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Einleitung Benétigte Programme (X)HTM ndgeriist Doctype

Benotigte Programme

Praktisch keine Voraussetzungen!

HTML ist reiner (ASCIl-)Text. Wenn man alle Elemente von
HTML und CSS mehr oder weniger auswendig beherrscht, dann
reicht der simpelste Texteditor wie notepad aus.
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http://www.chami.com/html-kit/
http://www.nvu.com/
http://www.bradsoft.com/
http://www.iol.ie/~locka/mozilla/control.htm
http://www.ftp-uploader.de/ftp-download.php4
http://www.rosenlundnielsen.dk/software/product_includehtml.php
http://www.chami.com/html-kit/plugins/info/hkh_w3c_offline/

Einleitung Benétigte Programme (X)HTML-Grundgeriist Doctype

Benotigte Programme

Praktisch keine Voraussetzungen!
HTML ist reiner (ASCIl-)Text. Wenn man alle Elemente von

HTML und CSS mehr oder weniger auswendig beherrscht, dann
reicht der simpelste Texteditor wie notepad aus.

ASCII: American Standard Code for Information Interchange

[ ASCII beinhaltet keinerlei Sonderzeichen, wie dt. Umlaute. Ebenso die Codierung von
asiat., hebrd. oder arab. Zeichen erfordert (eine spater diskutierte) Vorgehensweise. |
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Einleitung Benétigte Programme (X)HTML-Grundgeriist Doctype

Benotigte Programme

Praktisch keine Voraussetzungen!
HTML ist reiner (ASCIl-)Text. Wenn man alle Elemente von

HTML und CSS mehr oder weniger auswendig beherrscht, dann
reicht der simpelste Texteditor wie notepad aus.

ASCII: American Standard Code for Information Interchange

[ ASCII beinhaltet keinerlei Sonderzeichen, wie dt. Umlaute. Ebenso die Codierung von
asiat., hebrd. oder arab. Zeichen erfordert (eine spater diskutierte) Vorgehensweise. |

Trotzdem kann man sich das Editieren durch einige Programme einfacher machen
(hier nur Windows-Freeware!):
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Einleitung Benétigte Programme (X)HTML-Grundgeriist Doctype

Benotigte Programme

Praktisch keine Voraussetzungen!
HTML ist reiner (ASCIl-)Text. Wenn man alle Elemente von

HTML und CSS mehr oder weniger auswendig beherrscht, dann
reicht der simpelste Texteditor wie notepad aus.

ASCII: American Standard Code for Information Interchange

[ ASCII beinhaltet keinerlei Sonderzeichen, wie dt. Umlaute. Ebenso die Codierung von
asiat., hebrd. oder arab. Zeichen erfordert (eine spater diskutierte) Vorgehensweise. |

Trotzdem kann man sich das Editieren durch einige Programme einfacher machen
(hier nur Windows-Freeware!):

@ HTML-Kit — HTML Source-code Editor
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Einleitung Benétigte Programme (X)HTML-Grundgeriist Doctype

Benotigte Programme

Praktisch keine Voraussetzungen!
HTML ist reiner (ASCIl-)Text. Wenn man alle Elemente von

HTML und CSS mehr oder weniger auswendig beherrscht, dann
reicht der simpelste Texteditor wie notepad aus.

ASCII: American Standard Code for Information Interchange

[ ASCII beinhaltet keinerlei Sonderzeichen, wie dt. Umlaute. Ebenso die Codierung von
asiat., hebrd. oder arab. Zeichen erfordert (eine spater diskutierte) Vorgehensweise. |

Trotzdem kann man sich das Editieren durch einige Programme einfacher machen
(hier nur Windows-Freeware!):

@ HTML-Kit — HTML Source-code Editor
@ Nvu — WYSIWYG
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Benotigte Programme

Praktisch keine Voraussetzungen!

HTML ist reiner (ASCIl-)Text. Wenn man alle Elemente von
HTML und CSS mehr oder weniger auswendig beherrscht, dann
reicht der simpelste Texteditor wie notepad aus.

ASCII: American Standard Code for Information Interchange

[ ASCII beinhaltet keinerlei Sonderzeichen, wie dt. Umlaute. Ebenso die Codierung von
asiat., hebrd. oder arab. Zeichen erfordert (eine spater diskutierte) Vorgehensweise. |

Trotzdem kann man sich das Editieren durch einige Programme einfacher machen
(hier nur Windows-Freeware!):

@ HTML-Kit — HTML Source-code Editor
@ Nvu — WYSIWYG
@ TopStyle — CSS Editor
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Einleitung Benétigte Programme (X)HTML-Grundgeriist Doctype

Benotigte Programme

Praktisch keine Voraussetzungen!

HTML ist reiner (ASCIl-)Text. Wenn man alle Elemente von
HTML und CSS mehr oder weniger auswendig beherrscht, dann
reicht der simpelste Texteditor wie notepad aus.

ASCII: American Standard Code for Information Interchange

[ ASCII beinhaltet keinerlei Sonderzeichen, wie dt. Umlaute. Ebenso die Codierung von
asiat., hebrd. oder arab. Zeichen erfordert (eine spater diskutierte) Vorgehensweise. |

Trotzdem kann man sich das Editieren durch einige Programme einfacher machen
(hier nur Windows-Freeware!):

@ HTML-Kit — HTML Source-code Editor
@ Nvu — WYSIWYG
@ TopStyle — CSS Editor

@ Mozilla ActiveX Control — Gecko als Browser-preview
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Einleitung Benétigte Programme (X)HTML-Grundgeriist Doctype

Benotigte Programme

Praktisch keine Voraussetzungen!

HTML ist reiner (ASCIl-)Text. Wenn man alle Elemente von
HTML und CSS mehr oder weniger auswendig beherrscht, dann
reicht der simpelste Texteditor wie notepad aus.

ASCII: American Standard Code for Information Interchange

[ ASCII beinhaltet keinerlei Sonderzeichen, wie dt. Umlaute. Ebenso die Codierung von
asiat., hebrd. oder arab. Zeichen erfordert (eine spater diskutierte) Vorgehensweise. |

Trotzdem kann man sich das Editieren durch einige Programme einfacher machen
(hier nur Windows-Freeware!):
@ HTML-Kit — HTML Source-code Editor
@ Nvu — WYSIWYG
@ TopStyle — CSS Editor
@ Mozilla ActiveX Control — Gecko als Browser-preview
o

FTP-Uploader — fiir spateren Upload ins Internet
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Einleitung Benétigte Programme (X)HTML-Grundgeriist Doctype

Benotigte Programme

Praktisch keine Voraussetzungen!

HTML ist reiner (ASCIl-)Text. Wenn man alle Elemente von
HTML und CSS mehr oder weniger auswendig beherrscht, dann
reicht der simpelste Texteditor wie notepad aus.

ASCII: American Standard Code for Information Interchange

[ ASCII beinhaltet keinerlei Sonderzeichen, wie dt. Umlaute. Ebenso die Codierung von
asiat., hebrd. oder arab. Zeichen erfordert (eine spater diskutierte) Vorgehensweise. |

Trotzdem kann man sich das Editieren durch einige Programme einfacher machen
(hier nur Windows-Freeware!):

@ HTML-Kit — HTML Source-code Editor

Nvu — WYSIWYG

TopStyle — CSS Editor

Mozilla ActiveX Control — Gecko als Browser-preview
FTP-Uploader — fiir spateren Upload ins Internet
HTML-Kit Plug-ins: includeHTML , w3c offline Referenzen
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Einleitung 3endtigte Programme  (X)HTML-Grundgeriist Doctype

(X)HTML-Grundgeriist

<IDOCTYPE html| PUBLIC "—//W3C//DTD XHTML 1.0 Strict//EN”
"http://www.w3.0rg/TR/xhtml1/DTD/xhtmll—strict .dtd">
<htm!| xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Titeltext der Seite</title>
</head>
<body>
TEXT
</body>
</html>
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Einleitung Benétigte Programme (X)HTML-Grundgeriist Doctype

(X)HTML-Grundgeriist

<IDOCTYPE htm| PUBLIC "—//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0org/TR/xhtml|1/DTD/xhtmll—strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">

<head>

<title>Titeltext der Seite</title>

</head>

<body>

... TEXT ...

</body>

</htmlI>

Das html-Element beinhaltet zwei Elemente: das head- und das
body-Element. Das head-Element beinhaltet Metadaten iiber die
Seite. Das body-Element enthilt den eigentlichen (vom Browser
angezeigten) Inhalt.
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Einleitung gramme (X)HTN geriist Doctype

Doctype — von HTML und XML zu XHTML-+CSS

HTML als Auszeichnungssprache brauchte (wie jede
Programmiersprache auch!) 10 Jahre, von 1990 bis 2000, um iiber
ihre Kinderkrankheiten hinwegzukommen. Im Jahr 1999 endete mit
HTML 4.01 der Sprachzweig, der Inhalt/Struktur und Prasentation
vermischte.
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Einleitung Benétigte Programme (X)HTML-Grundgeriist Doctype

Doctype — von HTML und XML zu XHTML-+CSS

HTML als Auszeichnungssprache brauchte (wie jede
Programmiersprache auch!) 10 Jahre, von 1990 bis 2000, um iiber
ihre Kinderkrankheiten hinwegzukommen. Im Jahr 1999 endete mit
HTML 4.01 der Sprachzweig, der Inhalt/Struktur und Prasentation
vermischte.

Im Jahr 2000 wurde XHTML in Version 1.0 standardisiert.
XHTML enthalt ausschlieBlich Inhalt und Struktur, entsprechend
dem XML-Vorbild. Die Prisentations-Elemente sind vollstandig
durch die Cascading Style Sheet (CSS) Sprache ersetzt worden.
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Einleitung Bendtigte Programme (X)HTML-Grundgeriist Doctype

Doctype — von HTML und XML zu XHTML-+CSS

HTML als Auszeichnungssprache brauchte (wie jede
Programmiersprache auch!) 10 Jahre, von 1990 bis 2000, um iiber
ihre Kinderkrankheiten hinwegzukommen. Im Jahr 1999 endete mit
HTML 4.01 der Sprachzweig, der Inhalt/Struktur und Prasentation
vermischte.

Im Jahr 2000 wurde XHTML in Version 1.0 standardisiert.
XHTML enthalt ausschlieBlich Inhalt und Struktur, entsprechend
dem XML-Vorbild. Die Prisentations-Elemente sind vollstandig
durch die Cascading Style Sheet (CSS) Sprache ersetzt worden.

Die strikte Trennung erlaubt die einfachere Verarbeitung und
Erstellung von HTML.
(Browser-Implementierung, Konformitat in der Anzeige, ...)
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Einleitung 5 > rundgeriist Doctype

Doctype(2)

Der Vollstandigkeit halber soll angegeben werden
wie ein HTML 4.01 Dokument deklariert wird:
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Einleitung Programme (X)HTML-Grundgeriist Doctype

Doctype(2)

Der Vollstandigkeit halber soll angegeben werden
wie ein HTML 4.01 Dokument deklariert wird:

<!DOCTYPE HTML PUBLIC "—//W3C//DTD HTML 4.01 Transitional //EN"
"http://www.w3.0org/TR/html4 /loose.dtd">

<htmlI>. ..
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Einleitung 5 rogramme (X)HTM eriist Doctype

Doctype(2)

Der Vollstandigkeit halber soll angegeben werden
wie ein HTML 4.01 Dokument deklariert wird:

<IDOCTYPE HTML PUBLIC "—//W3C//DTD HTML 4.01 Transitional//EN”

"http://www.w3.0org/TR/html4/loose.dtd">
<htmlI>. ..

Die Verkniipfung von (X)HTML und CSS findet im
html-Dokument statt:
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Einleitung > Programme  (X)HTML-Grundgeriist Doctype

Doctype(2)

Der Vollstandigkeit halber soll angegeben werden
wie ein HTML 4.01 Dokument deklariert wird:
<IDOCTYPE HTML PUBLIC "—//W3C//DTD HTML 4.01 Transitional//EN"

"http://www.w3.0org/TR/html4/loose.dtd">
<htmlI>. ..

Die Verkniipfung von (X)HTML und CSS findet im
html-Dokument statt:

<head>

<link rel="stylesheet” type="text/css”
href="yourCSSfile.css” media="all" />

</head>
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Einleitung Bendtigte Programme (X)HTML-Grundgeriist Doctype

Doctype(2)

Der Vollstandigkeit halber soll angegeben werden
wie ein HTML 4.01 Dokument deklariert wird:
<IDOCTYPE HTML PUBLIC "—//W3C//DTD HTML 4.01 Transitional//EN"

"http://www.w3.0org/TR/html4/loose.dtd">
<htmlI>. ..

Die Verkniipfung von (X)HTML und CSS findet im
html-Dokument statt:

<head>

<link rel="stylesheet” type="text/css”
href="yourCSSfile.css” media="all" />

</head>

(Der Laie mége beachten, dass dies auch auf viele andere Arten mdglich wire, z.B.in
Form einer dritten Datei, die als Katalog-Datei die Zuweisung zwischen HTML- und

CSS-Dateien beschreiben kénnte.)
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Einleitung Bel e Programme (X)HTM ndgeriist Doctype

Doctype(3) — XHTML als XML

Ausserdem macht alleine die Doctype-Deklaration eines
XHTML-Dokuments dieses Dokument noch nicht zu giiltigem
XML. Dies wird erst durch folgenden Zusatz gewahrleistet:
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Einleitung Ben rogramme (X)HTML-Grundgeriist Doctype

Doctype(3) — XHTML als XML

Ausserdem macht alleine die Doctype-Deklaration eines
XHTML-Dokuments dieses Dokument noch nicht zu giiltigem
XML. Dies wird erst durch folgenden Zusatz gewahrleistet:

<?xml version="1.0"7>
<I!DOCTYPE ... XHTML ...
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Einleitung Ber rogramme (X)HTM eriist Doctype

Doctype(3) — XHTML als XML

Ausserdem macht alleine die Doctype-Deklaration eines
XHTML-Dokuments dieses Dokument noch nicht zu giiltigem
XML. Dies wird erst durch folgenden Zusatz gewahrleistet:

<?xml version="1.0"7>
<!DOCTYPE ... XHTML ...

Allerdings sollte im Moment darauf verzichtet werden, weil:
... unvollstandiger Browser-Support ...
... HTML-Engine versus XML-Engine ...
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Grundelemente ext  Bilder CSS-Einfiihrung Links Anchors

Agenda — Referenz

© Grundelemente

o Text
Bilder
CSS-Einfiihrung
Links

°
°
°
@ Anchors
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text — Absatze und Zeilenumbriiche
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text — Absatze und Zeilenumbriiche

Normaler FlieBtext ist meist in verschiedene Absitze unterteilt. In
html deklariert das paragraph-Tag einen Absatz:

<p>
ganz viel
Absatz Text

</p>
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text — Absatze und Zeilenumbriiche

Normaler FlieBtext ist meist in verschiedene Absitze unterteilt. In
html deklariert das paragraph-Tag einen Absatz:

<p>
ganz viel
Absatz Text
</p>

Browser zeigen Absdtze meist durch eine Zeilenabstand etwas
abgesetzt von anderen Elementen (wie z.B. anderen Absitzen) an.
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text — Absatze und Zeilenumbriiche

Normaler FlieBtext ist meist in verschiedene Absitze unterteilt. In
html deklariert das paragraph-Tag einen Absatz:

<p>
ganz viel
Absatz Text
</p>

Browser zeigen Absdtze meist durch eine Zeilenabstand etwas
abgesetzt von anderen Elementen (wie z.B. anderen Absitzen) an.
Mé&chte man (z.B. innerhalb eines Absatzes) einen Zeilenumbruch
— der sich im Gegensatz zu einem neuen Absatz nicht absetzt —
dann bendtigt man das break-Tag:

<br />
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text — Absatze und Zeilenumbriiche

Normaler FlieBtext ist meist in verschiedene Absitze unterteilt. In
html deklariert das paragraph-Tag einen Absatz:

<p>
ganz viel
Absatz Text
</p>

Browser zeigen Absdtze meist durch eine Zeilenabstand etwas
abgesetzt von anderen Elementen (wie z.B. anderen Absitzen) an.
Mé&chte man (z.B. innerhalb eines Absatzes) einen Zeilenumbruch
— der sich im Gegensatz zu einem neuen Absatz nicht absetzt —
dann bendtigt man das break-Tag:

<br />

Diese spezielle Schreibweise mit dem “/” am Ende des Tags, erspart ein Ende-Tag zu
schreiben. Es wird immer dann eingesetzt, wenn ein Tag fiir sich selbst steht und
keinen Text umschlieBt. (z.B. auch Bilder: img-Tag — siehe spater)
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text(2) — Uberschriften

Uberschriften (= headings) gibt es in sechs Stufen:

<h1>Uberschrift

der Stufe 1</hl>

<h6>Uberschrift der Stufe 6</h6>
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text(2) — Uberschriften

Uberschriften (= headings) gibt es in sechs Stufen:

<h1>Uberschrift der Stufe 1</h1>

<h6>Uberschrift der Stufe 6</h6>

Diese werden von Browsern meist in unterschiedlicher GroBe
dargestellt.
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text(3) — Zeichenkodierung

Viele Zeichen sind in der ASCII-Kodierung nicht enthalten, z.B.
deutsche Umlaute. Daher muss man sie mit einer speziellen
ASCll-codierten Zeichenkette umschreiben.
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text(3) — Zeichenkodierung

Viele Zeichen sind in der ASCII-Kodierung nicht enthalten, z.B.
deutsche Umlaute. Daher muss man sie mit einer speziellen
ASCll-codierten Zeichenkette umschreiben.

Beispiele

Das geschiitzte Leerzeichen (&nbsp), die Umlaute & (&auml;) 6 (&ouml;) i (&uuml;),
das scharfe B (&szlig;), das Euro Zeichen € (&euro;) und das Copyright Zeichen (©)
(&copy:).
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Text(3) — Zeichenkodierung

Viele Zeichen sind in der ASCII-Kodierung nicht enthalten, z.B.
deutsche Umlaute. Daher muss man sie mit einer speziellen
ASCll-codierten Zeichenkette umschreiben.

Beispiele

Das geschiitzte Leerzeichen (&nbsp), die Umlaute & (&auml;) 6 (&ouml;) i (&uuml;),
das scharfe B (&szlig;), das Euro Zeichen € (&euro;) und das Copyright Zeichen (©)
(&copy:).

| A\

Nicht auswendig merken!

Mit HTML Tidy, integriert in HTML-Kit, 138t sich die
Zeichentransformation automatisieren. Es diirfen also deutsche
Zeichen eingegeben werden!

A
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Bilder

Bilder kdnnen durch einen Verweis auf die Bild-Datei “eingefiigt”
werden. Dies geschieht mit dem image-Tag:

<img alt="XHTML Logo” src="logo/valid —xhtml —1.0.gif"
height="15px" width="80px" />
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Bilder

Bilder kdnnen durch einen Verweis auf die Bild-Datei “eingefiigt’
werden. Dies geschieht mit dem image-Tag:

<img alt="XHTML Logo” src="logo/valid —xhtml —1.0.gif"
height="15px" width="80px" />

Das src=""-Attribut gibt den Dateinamen an.
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

Bilder

Bilder kdnnen durch einen Verweis auf die Bild-Datei “eingefiigt”
werden. Dies geschieht mit dem image-Tag:

<img alt="XHTML Logo” src="logo/valid —xhtml —1.0.gif"
height="15px" width="80px" />

Das src=""-Attribut gibt den Dateinamen an.

Da das Bild erst durch den Browser eingefligt wird, und da es auch
nicht-graphische Browser gibt (z.B. fiir Behinderte oder auch
Linux-User ;-), sollte immer mit dem alt=""-Attribut ein
ersatzweiser Text angegeben werden.
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

CSS-Einfiihrung — Einbindung oder Einbettung in XHTML

Einleitung:
@ CSS ist eine unmittelbare Erganzung zu (X)HTML

Drei Orte CSS Auszeichnungen zu schreiben:
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Grundelemente Text Bilder CSS-Einfiihrung Links Anchors

CSS-Einfiihrung — Einbindung oder Einbettung in XHTML

Einleitung:
e CSS ist eine unmittelbare Ergénzung zu (X)HTML

@ CSS dient zur Definition von Formateigenschaften einzelner
html-Tags

Drei Orte CSS Auszeichnungen zu schreiben:
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Grundelemente ext Bilder CSS-Einfiihrung Links Anchors

CSS-Einfiihrung — Einbindung oder Einbettung in XHTML

Einleitung:
e CSS ist eine unmittelbare Ergénzung zu (X)HTML

@ CSS dient zur Definition von Formateigenschaften einzelner
html-Tags

o Moglichkeit: Formate zentral zu verwalten — spart
Kodierarbeit und macht die HTML-Dateien kleiner

Drei Orte CSS Auszeichnungen zu schreiben:
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Grundelemente Bilder CSS-Einfiihrung Links Anchors

CSS-Einfiihrung — Einbindung oder Einbettung in XHTML

Einleitung:
e CSS ist eine unmittelbare Ergénzung zu (X)HTML

@ CSS dient zur Definition von Formateigenschaften einzelner
html-Tags

o Moglichkeit: Formate zentral zu verwalten — spart
Kodierarbeit und macht die HTML-Dateien kleiner

@ Aktuelle Version: CSS 2.0

Drei Orte CSS Auszeichnungen zu schreiben:
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CSS-Einfiihrung — Einbindung oder Einbettung in XHTML

Einleitung:
e CSS ist eine unmittelbare Ergénzung zu (X)HTML

@ CSS dient zur Definition von Formateigenschaften einzelner
html-Tags

o Moglichkeit: Formate zentral zu verwalten — spart
Kodierarbeit und macht die HTML-Dateien kleiner

o Aktuelle Version: CSS 2.0

Drei Orte CSS Auszeichnungen zu schreiben:
© In externer Datei (referenziert im Header)
Q@ Im html-Header
© Tag-lokal (im style=""Attribut eines Tags)
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CSS-Einfiihrung(2) — CSS in externer Datei

Im html-Header wird die externe CSS Datei referenziert:

<head>

<link rel="stylesheet” type="text/css”
href="yourCSSfile.css” media="all" />

</head>
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CSS-Einfiihrung(2) — CSS in externer Datei

Im html-Header wird die externe CSS Datei referenziert:

<head>
<link rel="stylesheet” type="text/css”
href="yourCSSfile.css” media="all" />

</head>

In der yourCSSfile.css Datei steht dann einfach:

body {
font—family: Arial ,sans—serif;
color: #333333;
background: White;

}
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CSS-Einfiihrung(3) — Im Header eingebettetes CSS

CSS kann fiir jede html-Datei einzeln definiert werden:

<head>
<style type="text/css">
<l—
body{
font—family: Arial ,sans—serif;
color: #333333;
background: White; }
—
</style>
</head>
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CSS-Einfiihrung(4) — Tag-lokales CSS

Im style="""Attribut eines jeden Tags kdnnen lokale CSS
Auszeichnungen beschrieben werden:

<body style="font—family: Arial ,sans—serif;
color: #333333; background: White;" >

</body>
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CSS-Einfiihrung(5) — CSS-Selektoren

Die Formatierung durch CSS kann anhand von drei Kategorien
vorgenommen werden:

@ Tag-Namen
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CSS-Einfiihrung(5) — CSS-Selektoren

Die Formatierung durch CSS kann anhand von drei Kategorien
vorgenommen werden:

o Tag-Namen

@ Klassen (— html class=""-Attribut)
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CSS-Einfiihrung(5) — CSS-Selektoren

Die Formatierung durch CSS kann anhand von drei Kategorien
vorgenommen werden:

o Tag-Namen
o Klassen (— html class=""-Attribut)
@ Identifikatoren (— html id=""-Attribut)
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CSS-Einfiihrung(5) — CSS-Selektoren

Die Formatierung durch CSS kann anhand von drei Kategorien
vorgenommen werden:

o Tag-Namen
o Klassen (— html class=""-Attribut)
o Identifikatoren (— html id=""Attribut)

Tags derselben Klasse kdnnen mehrfach in einem html-Dokument vorkommen. Ein
Tag mit einer spez. ID darf nur genau einmal ein einem html-Dokument existieren.
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CSS-Einfiihrung(5) — CSS-Selektoren

Die Formatierung durch CSS kann anhand von drei Kategorien
vorgenommen werden:

o Tag-Namen
o Klassen (— html class=""-Attribut)
o Identifikatoren (— html id=""Attribut)

Tags derselben Klasse kdnnen mehrfach in einem html-Dokument vorkommen. Ein
Tag mit einer spez. ID darf nur genau einmal ein einem html-Dokument existieren.

Vererbung

CSS Formatierung eines iibergeordneten Tags werden auf eingeschlossene Tags vererbt.
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CSS-Einfiihrung(5) — CSS-Selektoren

Die Formatierung durch CSS kann anhand von drei Kategorien
vorgenommen werden:

o Tag-Namen
o Klassen (— html class=""-Attribut)
o Identifikatoren (— html id=""Attribut)

Tags derselben Klasse kdnnen mehrfach in einem html-Dokument vorkommen. Ein
Tag mit einer spez. ID darf nur genau einmal ein einem html-Dokument existieren.

Vererbung

CSS Formatierung eines iibergeordneten Tags werden auf eingeschlossene Tags vererbt.

Zum Beispiel gilt die “font"-Angabe des body-Tags fiir alle in body eingeschlossenen

Tags — solange nicht eine Tag-spezifischere CSS-Formatierung dies “liberschreibt”.
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CSS-Einfiihrung(6) — CSS-Selektoren(2)

Bsp: Formate fiir HTML-Tags
p{ ...}
P,

i { ...} <p>YES<p> <i>YES</i>
p i{ <p>NO<i>YES</ i><p> <i>NO</i>

-
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CSS-Einfiihrung(6) — CSS-Selektoren(2)

Bsp: Formate fiir HTML-Tags
p{ ...}
P,

i { ...} <p>YES<p> <i>YES</i>
p i { ...} <p>NO<i>YES</ i><p> <i>NO</i>

Bsp: Formate auf Basis der html-Klasse

.classNameBeliebig { ... }
x«.classNameBeliebig { ... }
p.classNameBeliebig { ... }

Christoph Peter Neumann HTML und CSS Kurs



Grundelemente er CSS-Einfiihrung Links Anchors

CSS-Einfiihrung(6) — CSS-Selektoren(2)

Bsp: Formate fiir HTML-Tags
p{ ...}
P,

i { ...} <p>YES<p> <i>YES</i>
p i { ...} <p>NO<i>YES</ i><p> <i>NO</i>

Bsp: Formate auf Basis der html-Klasse

.classNameBeliebig { ... }
x«.classNameBeliebig { ... }
p.classNameBeliebig { ... }

Bsp: Formate auf Basis einer html-ID

#idNameBeliebig { ... }
s«#idNameBeliebig { ... }
p#idNameBeliebig { ... }
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CSS-Einfiihrung(7) — CSS-Selektoren(3) advanced

Es gibt noch weitere Moglichkeiten fiir verschachtelte
HTML-Elemente:
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CSS-Einfiihrung(7) — CSS-Selektoren(3) advanced

Es gibt noch weitere Moglichkeiten fiir verschachtelte
HTML-Elemente:

Genau eine Ebene unterhalb:
div>p { ... } <div> <p>YES</p> <p>YES</p> </div>

Christoph Peter Neumann HTML und CSS Kurs



Grundelemente er CSS-Einfiihrung Links Anchors

CSS-Einfiihrung(7) — CSS-Selektoren(3) advanced

Es gibt noch weitere Moglichkeiten fiir verschachtelte
HTML-Elemente:

Genau eine Ebene unterhalb:
div>p { ... } <div> <p>YES</p> <p>YES</p> </div>

Genau zwei Ebenen unterhalb:
div = i { ... } <div> <i>NO</i> <p>..<i>YES</i>..</p> </div>
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CSS-Einfiihrung(7) — CSS-Selektoren(3) advanced

Es gibt noch weitere Moglichkeiten fiir verschachtelte
HTML-Elemente:

Genau eine Ebene unterhalb:
div>p { ... } <div> <p>YES</p> <p>YES</p> </div>

Genau zwei Ebenen unterhalb:
div = i { ... } <div> <i>NO</i> <p>..<i>YES</i>..</p> </div>

Elemente unmittelbar auf ein Element folgend:

div +p { ... } <div> <p>YES</p> <p>NO</p> </div>
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CSS-Einfiihrung(7) — CSS-Selektoren(3) advanced

Es gibt noch weitere Moglichkeiten fiir verschachtelte
HTML-Elemente:

Genau eine Ebene unterhalb:
div>p { ... } <div> <p>YES</p> <p>YES</p> </div>

Genau zwei Ebenen unterhalb:
div = i { ... } <div> <i>NO</i> <p>..<i>YES</i>..</p> </div>

Elemente unmittelbar auf ein Element folgend:

div +p { ... } <div> <p>YES</p> <p>NO</p> </div>

“+" wird von den Browsern (leider) noch nicht gut unterstiitzt!
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CSS-Einfiihrung(8) — Ausrichtung von Bildern

Bilder kann man durch CSS verschieden ausrichten:

<img alt="XHTML Logo"” src="logo/valid —xhtml —1.0.gif”
height="15px" width="80px"
style="float: right;
padding: Opx 10px Opx 10px;
margin: 0 5px 5px 0;" />

@ “float:” sorgt fiir eine “TextumflieBung” und richtet das Bild
am rechten oder linken Rand aus. (Nur nachfolgender Text
wird zur UmflieBung verwendet!)
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CSS-Einfiihrung(8) — Ausrichtung von Bildern

Bilder kann man durch CSS verschieden ausrichten:

<img alt="XHTML Logo"” src="logo/valid —xhtml —1.0.gif”
height="15px" width="80px"
style="float: right;
padding: Opx 10px Opx 10px;
margin: 0 5px 5px 0;" />

@ “float:” sorgt fiir eine “TextumflieBung” und richtet das Bild
am rechten oder linken Rand aus. (Nur nachfolgender Text
wird zur UmflieBung verwendet!)

@ “padding:” ist der Rand nach aussen
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CSS-Einfiihrung(8) — Ausrichtung von Bildern

Bilder kann man durch CSS verschieden ausrichten:

<img alt="XHTML Logo"” src="logo/valid —xhtml —1.0.gif”
height="15px" width="80px"
style="float: right;
padding: Opx 10px Opx 10px;
margin: 0 5px 5px 0;" />

@ “float:” sorgt fiir eine “TextumflieBung” und richtet das Bild
am rechten oder linken Rand aus. (Nur nachfolgender Text
wird zur UmflieBung verwendet!)

@ “padding:” ist der Rand nach aussen

@ “margin:” ist der Rand nach innen
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CSS-Einfiihrung(9) — Ausrichtung von Bildern(2)

Man kann Bilder auch pixelgenau positionieren:

<img id="test"
alt="XHTML Logo"” src="logo/valid —xhtml —1.0.gif”
height="15px" width="80px" />

img#test {
position: absolute;
top: 100px;
left: 300px;

}
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CSS-Einfiihrung(9) — Ausrichtung von Bildern(2)

Man kann Bilder auch pixelgenau positionieren:

<img id="test”
alt="XHTML Logo"” src="logo/valid —xhtml —1.0.gif”
height="15px" width="80px" />

img#test {
position: absolute;
top: 100px;
left: 300px;

}

@ “top:” und “left:” sind Abstandsangaben (Es gibt auch
“bottom:" und “right:")
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CSS-Einfiihrung(9) — Ausrichtung von Bildern(2)

Man kann Bilder auch pixelgenau positionieren:

<img id="test”
alt="XHTML Logo"” src="logo/valid —xhtml —1.0.gif”
height="15px" width="80px" />

img#test {
position: absolute;
top: 100px;
left: 300px;

}

@ “top:” und “left:” sind Abstandsangaben (Es gibt auch
“bottom:" und "right:")

@ Durch “position: absolute” gelten die Abstdnde immer relativ
zur gesamten html-Seite.

Christoph Peter Neumann HTML und CSS Kurs



Grundelemente er CSS-Einfiihrung Links Anchors

CSS-Einfiihrung(10) — Ausrichtung von Bildern(3)

o Statt “absolute” gibt es z.B. auch "relative”™: Wenn das Bild
z.B. innerhalb eines speziellen Bereichs (div-Tag — spater!)
steht, der eine gewisse Position einnimmt, dann wird bei
“relative” das Bild relativ zum umgebenden Bereich positioniert
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CSS-Einfiihrung(10) — Ausrichtung von Bildern(3)

o Statt “absolute” gibt es z.B. auch "relative”™: Wenn das Bild
z.B. innerhalb eines speziellen Bereichs (div-Tag — spater!)
steht, der eine gewisse Position einnimmt, dann wird bei
“relative” das Bild relativ zum umgebenden Bereich positioniert

@ Neben “absolute” und “relative” gibt es auch “fixed”. Dies wirkt
dhnlich zu “absolute”. Doch wahrend “absolute” zur ganzen
Seite hin positioniert, wirkt “fixed” beziiglich des
Browser-Fensters! D.h. beim Scrollen des Inhalt wird das
“position: fixed;"-positionierte Element nicht gescrollt!

Christoph Peter Neumann HTML und CSS Kurs



Grundelemente ext  Bilder CSS-Einfiihrung Links Anchors

Links — anchor-Tag mit href=

Das eine Elemente durch das sich HTML im wesentlichen definiert
ist der HyperLink:

<a href="http://www.8ung.at/chrl5t0ph/">TEXT der
nun verlink ist</a>

p.t.o —
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Links — anchor-Tag mit href=

Das eine Elemente durch das sich HTML im wesentlichen definiert
ist der HyperLink:

<a href="http://www.8ung.at/chrl5t0ph/">TEXT der
nun verlink ist</a>

Eine der wichtigsten Unterscheidungen ist die zwischen:

p.t.o —
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Links — anchor-Tag mit href=

Das eine Elemente durch das sich HTML im wesentlichen definiert
ist der HyperLink:

<a href="http://www.8ung.at/chrl5t0ph/">TEXT der
nun verlink ist</a>

Eine der wichtigsten Unterscheidungen ist die zwischen:
@ Sprechende Links
@ Nicht-sprechende Links

p.t.o —
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Links — anchor-Tag mit href=

Das eine Elemente durch das sich HTML im wesentlichen definiert
ist der HyperLink:

<a href="http://www.8ung.at/chrl5t0ph/">TEXT der
nun verlink ist</a>

Eine der wichtigsten Unterscheidungen ist die zwischen:
@ Sprechende Links
@ Nicht-sprechende Links

p.t.o —

Christoph Peter Neumann HTML und CSS Kurs



Grundelemente ext  Bilder CSS-Einfiihrung Links Anchors

Links(2) — Sprechend versus Nicht-sprechend

Bsp: Ein nicht-sprechender Link:

Den Download zu HTML-Kit finden Sie
<a href="http://www.chami.com/html—kit/download/">hier</a>.
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Links(2) — Sprechend versus Nicht-sprechend

Bsp: Ein nicht-sprechender Link:

Den Download zu HTML-Kit finden Sie
<a href="http://www.chami.com/html—kit/download/">hier</a>.

Bsp: Besser — aber nicht wirklich sprechend:

HTML-Kit kann man kostenlos
<a href="http://www.chami.com/html—kit/download/">downloaden</a>.
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Links(2) — Sprechend versus Nicht-sprechend

Bsp: Ein nicht-sprechender Link:

Den Download zu HTML-Kit finden Sie
<a href="http://www.chami.com/html—kit/download/">hier</a>.

Bsp: Besser — aber nicht wirklich sprechend:

HTML-Kit kann man kostenlos
<a href="http://www.chami.com/html—kit/download/">downloaden</a>.

Bsp: Jetzt der sprechende Link:

<a href="http://www.chami.com/html—kit/">HTML-Kit</a>
kann man kostenlos downloaden.
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Links(2) — Sprechend versus Nicht-sprechend

Bsp: Ein nicht-sprechender Link:

Den Download zu HTML-Kit finden Sie
<a href="http://www.chami.com/html—kit/download/">hier</a>.

Bsp: Besser — aber nicht wirklich sprechend:

HTML-Kit kann man kostenlos
<a href="http://www.chami.com/html—kit/download/">downloaden</a>.

Bsp: Jetzt der sprechende Link:

<a href="http://www.chami.com/html—kit/">HTML-Kit</a>
kann man kostenlos downloaden.

So soll’s sein — Sprechend?

<a href="http://www.chami.com/html—kit/">HTML-Kit</a>
kann man kostenlos <a href="http://www.chami.com/
html—kit /download /">downloaden</a>.
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Links(3) — Verlinkte Bilder

Um ein Bild mit einem HyperLink zu unterlegen, muss man das
Bild einfach nur in ein a-Tag geben:

<a href="http://www.w3.o0rg/TR/xhtmll/">
<img alt="XHTML Logo" src="logo/valid —xhtml —1.0.gif"
height="15px" width="80px" />

</a>

In der Regel werden Browser dann das gesamte Bild mit einem
Rahmen umgeben. Wenn man das nicht moéchte muss man fiir
solche Bilder eine CSS-Regel angeben:

a img {border: none;}
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Links(4) — Spezielles CSS

Wenn der Benutzer einen Link schon besucht hat, weiB der
Browser davon und ist in der Lage unbesuchte Links (a:link) und
besuchte Links (a:visited) eine jeweils andere Farbe zu geben. Dies
ist wiederum durch CSS steuerbar:

a:link , a:visited , a:hover {
color: #006699;
text—decoration: none;

}
a:visited { color: #004466; }
a:hover { text—decoration: underline; }

a:hover bestimmt das aussehen des Links, wenn der Benutzer den
Maus-Cursor iiber den Link bewegt.

Ausserdem sahen wir hier auch ein Beispiel, wie sich Definitionen
fiir ein und dasselbe Element auch durchaus verteilen darf.
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Anchors — anchor-Tag mit id=

Das anchor-Tag, das zur Definition von HyperLinks dient, hat auch
noch eine andere Bedeutung:
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Anchors — anchor-Tag mit id=

Das anchor-Tag, das zur Definition von HyperLinks dient, hat auch
noch eine andere Bedeutung:

Er erlaubt Anchors/“Ansprungspunkte” zu deklarieren, v.a. im
Text, die dann z.B. durch eine Navigationsleiste angesprungen
werden konnen.
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Anchors — anchor-Tag mit id=

Das anchor-Tag, das zur Definition von HyperLinks dient, hat auch
noch eine andere Bedeutung:

Er erlaubt Anchors/“Ansprungspunkte” zu deklarieren, v.a. im
Text, die dann z.B. durch eine Navigationsleiste angesprungen
werden konnen.

<a id="beliebigerAnchorName”"></a>An diese Stelle
kann man per Link verweisen ...
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Anchors — anchor-Tag mit id=

Das anchor-Tag, das zur Definition von HyperLinks dient, hat auch
noch eine andere Bedeutung:

Er erlaubt Anchors/“Ansprungspunkte” zu deklarieren, v.a. im
Text, die dann z.B. durch eine Navigationsleiste angesprungen
werden konnen.

<a id="beliebigerAnchorName”"></a>An diese Stelle
kann man per Link verweisen ...

Und jetzt verweisen wir an die
<a href="#beliebigerAnchorName”">Stelle mit
dem Anchor</a>.
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Anchors(2)

Beachte:
@ Der Anchor-Name entspricht der Id des a-Tags
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Anchors(2)

Beachte:
@ Der Anchor-Name entspricht der Id des a-Tags
@ Um einen Anchor anzuspringen, muss man der entsprechenden
Id ein # voranstellen.
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Anchors(2)

Beachte:
@ Der Anchor-Name entspricht der Id des a-Tags
@ Um einen Anchor anzuspringen, muss man der entsprechenden
Id ein # voranstellen.
@ Man kann auch Anchors von “aussen” anspringen:
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Text Bilder CSS-Einfiihrung Links
Anchors(2)

Anchors

Beachte:

@ Der Anchor-Name entspricht der Id des a-Tags

@ Um einen Anchor anzuspringen, muss man der entsprechenden
Id ein # voranstellen.

@ Man kann auch Anchors von “aussen” anspringen:
<p>So verweisen wir von "aussen”

<a href="http://www.8ung.at/

chr15t0ph /webPublishing . html|#WebSpaceProviderFree ">
in

eine meiner Seiten hinein</a>.
</p>
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Anchors(2)

Bilder CSS-Einfiihrung Links Anchors

Beachte:

@ Der Anchor-Name entspricht der Id des a-Tags

@ Um einen Anchor anzuspringen, muss man der entsprechenden
Id ein # voranstellen.

@ Man kann auch Anchors von “aussen” anspringen:
<p>So verweisen wir von "aussen”
<a href="http://www.8ung.at/

chr15t0ph /webPublishing . html#WebSpaceProviderFree ">
in eine meiner Seiten hinein</a>.
</p>

Seit XHTML 1.0 kann im Grunde jedes Element mit eigener Id
durch einen #-Link angesprungen werden!

Dadurch sind a-Tags fiir Ansprungpunkte eigentlich nicht mehr von
Bedeutung!

(In HTML gab es das name=""-Attribut, anstelle der Id!)
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

Agenda — Referenz

© Ubungen

o HTML-Kit
Erste Seite
Vorschau
Inhalte
Shortcuts
Plug-ins
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug

HTML-Kit — Installation

Als erstes installieren wir als Vorbereitung
“Mozilla ActiveX Control v1.6™
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http://www.iol.ie/~locka/mozilla/control.htm
http://www.chami.com/html-kit/download/

Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug

HTML-Kit — Installation

Als erstes installieren wir als Vorbereitung
“Mozilla ActiveX Control v1.6™

@ “Install” ... “Close”
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http://www.chami.com/html-kit/download/

Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Installation

Als erstes installieren wir als Vorbereitung
“Mozilla ActiveX Control v1.6™

@ “Install” ... “Close”

@ Das war's schon. Jetzt wird in HTML-Kit die Gecko-Engine
als Preview-Moglichkeit funktionieren.
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http://www.iol.ie/~locka/mozilla/control.htm
http://www.chami.com/html-kit/download/

Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts

HTML-Kit — Installation

Als erstes installieren wir als Vorbereitung
“Mozilla ActiveX Control v1.6™

@ “Install” ... “Close”

@ Das war's schon. Jetzt wird in HTML-Kit die Gecko-Engine
als Preview-Moglichkeit funktionieren.

Jetzt installieren wir HT ML-Kit:
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Installation

Als erstes installieren wir als Vorbereitung
“Mozilla ActiveX Control v1.6™

@ “Install” ... “Close”

@ Das war's schon. Jetzt wird in HTML-Kit die Gecko-Engine
als Preview-Moglichkeit funktionieren.

Jetzt installieren wir HT ML-Kit:

O Kilicke “Ja", “Next", “Yes", “Next"”, “Next" (Full Installation),
“Next" und “Install” ... “Finish”
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Installation

Als erstes installieren wir als Vorbereitung
“Mozilla ActiveX Control v1.6™

@ “Install” ... “Close”
@ Das war's schon. Jetzt wird in HTML-Kit die Gecko-Engine
als Preview-Moglichkeit funktionieren.
Jetzt installieren wir HT ML-Kit:

O Kilicke “Ja", “Next", “Yes", “Next"”, “Next" (Full Installation),
“Next" und “Install” ... “Finish”

@ HTML-Kit wird das erste mal gestartet: “Yes”, “OK” (Windows
Integration Fenster), “Yes”; dann “No” (Download Web Links
now?), “No" (Check for Updates) und “No" (take a web tour?)
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Die erste HTML Seite

@ SchlieBlich erscheint der Standard-BegriiBungs-Wizard: Und
wir konnen gleich mal “Create a new file” mit “OK" bestatigen.
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Die erste HTML Seite

@ SchlieBlich erscheint der Standard-BegriiBungs-Wizard: Und
wir konnen gleich mal “Create a new file” mit “OK" bestatigen.

@ Wir I6schen als erstes mit Strg+A (“alles markieren”) und
Delete das Standard-Grundgeriist, weil es fiir das veraltete
HTML 4.01 ist. Dann erstellt man das XHTML 1.0
Grundgeriist ganz einfach mit: [Actions > Document >
“HTML 4.01 Document - Transitional” > “XHTML 1.0
Document - Strict"]
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Die erste HTML Seite

@ SchlieBlich erscheint der Standard-BegriiBungs-Wizard: Und
wir konnen gleich mal “Create a new file” mit “OK" bestatigen.

@ Wir I6schen als erstes mit Strg+A (“alles markieren”) und
Delete das Standard-Grundgeriist, weil es fiir das veraltete
HTML 4.01 ist. Dann erstellt man das XHTML 1.0
Grundgeriist ganz einfach mit: [Actions > Document >
“HTML 4.01 Document - Transitional” > “XHTML 1.0
Document - Strict"]

o (Der Zwischenmenii-Eintrag "HTML 4.01 Document -
Transitional” heisst so, weil's der erste Eintrag in der
darauffolgenden List ist. BI&d, is' aber so ;-)

o Das Menii unter [Actions] ist iibrigens iiber die Symbolleiste
eins-zu-eins abgebildet! Also [SymbL > Document >
[rechtestes Symb— Dropdown] > “XHTML 1.0 Document -
Strict']
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Browser-Vorschau

@ Wir schreiben einen kurzen Text zwischen die body-Tags ...
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HTML-Kit — Browser-Vorschau

@ Wir schreiben einen kurzen Text zwischen die body-Tags ...

© Browser-Vorschau:
o Die Taste F12 toggelt zwischen der “Editor"- und der
“Preview"-Ansicht
o Gleich mal ausprobieren: mehrmals F12 driicken!
o In der Preview-Ansicht kann auch statt IE die Gecko Engine
verwendet werden: Am unteren Rand der Preview-Ansicht auf

[ Gecko Mode ] klicken.
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HTML-Kit — Text-Inhalte

Freies tiben

Bitte jetzt einige Uberschriften und Absatze eingeben.

Ein bisschen CSS: z.B. Schriftart auf Arial.

Dann vielleicht ein Bild einbinden?

SchlieBlich mindestens einen Link setzen (z.B. zu www.google.de).
Nach Lust und Laune Anchors setzen und “anspringende” Links
erstellen. )
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Text-Inhalte

Freies tiben

Bitte jetzt einige Uberschriften und Absatze eingeben.

Ein bisschen CSS: z.B. Schriftart auf Arial.

Dann vielleicht ein Bild einbinden?

SchlieBlich mindestens einen Link setzen (z.B. zu www.google.de).
Nach Lust und Laune Anchors setzen und “anspringende” Links
erstellen.

Aber nicht vorschnell sein!!

| \

Unter keinen Umstdnden ungeduldig sein!
Auf keinen Fall ausprobieren: Listen und Tabellen.
Immer eins nach dem anderen!
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Keyboard Shortcuts

Keyboard Shortcuts kann man eingeben unter:
[Tools > Customize > “Customize Keyboard Shortcuts...”
(Ctrl-F10) && "Add..."]
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HTML-Kit — Keyboard Shortcuts

Keyboard Shortcuts kann man eingeben unter:
[Tools > Customize > “Customize Keyboard Shortcuts...”
(Ctrl-F10) && "Add..."]

© Links

e “Shortcut key™: Ctrl-Shift-L
o “New Command” > “Instert text™

<a href="|">{{SELTEXT}}</a>

e "< Add" nicht vergessen, erst dann “OK"
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Keyboard Shortcuts

Keyboard Shortcuts kann man eingeben unter:
[Tools > Customize > “Customize Keyboard Shortcuts...”
(Ctrl-F10) && "Add..."]

© Links

e “Shortcut key™: Ctrl-Shift-L
o “New Command” > “Instert text™

<a href="|">{{SELTEXT}}</a>

e "< Add" nicht vergessen, erst dann “OK"
@ Anchors

e “Shortcut key”: Ctrl-Shift-A
o “New Command” > “Instert text™

<a id="{{SELTEXT}}|"></a>{{SELTEXT}}
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Ubungen ML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Keyboard Shortcuts

@ HTML Tidy

e “Shortcut key" Ctrl-Shift-Alt-T
o “New Command” > “Action™
“Tools > HTML Tidy" plus “Convert to XHTML"
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Keyboard Shortcuts

Q@ HTML Tidy
e “Shortcut key" Ctrl-Shift-Alt-T
o “New Command” > “Action™
“Tools > HTML Tidy" plus “Convert to XHTML"
@ HTML Tidy: Beautify

e “Shortcut key”: Ctrl-Shift-Alt-B
o “New Command” > “Action™
“Tools > HTML Tidy" plus “Indent tags / beautify"

Christoph Peter Neumann HTML und CSS Kurs
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HTML-Kit — Keyboard Shortcuts

Q@ HTML Tidy
e “Shortcut key" Ctrl-Shift-Alt-T
o “New Command” > “Action™
“Tools > HTML Tidy" plus “Convert to XHTML"
@ HTML Tidy: Beautify
e “Shortcut key”: Ctrl-Shift-Alt-B
o “New Command” > “Action™
“Tools > HTML Tidy" plus “Indent tags / beautify"
© Copy Output to Editor

e “Shortcut key": Ctrl-Shift-Alt-C
e “New Command” > “Menu command™:
“MCopyOutputToEditor”
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Ubungen \ site Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Plug-ins

Zusatzlich noch die wichtigsten HTML-Kit Plug-ins:
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http://www.rosenlundnielsen.dk/software/product_includehtml.php
http://www.chami.com/html-kit/plugins/info/hkh_w3c_offline/

Ubungen ML-Ki E site Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Plug-ins

Zusatzlich noch die wichtigsten HTML-Kit Plug-ins:
© includeHTML

o “Next”, “Yes", “Next"”, wahle “Full installation”, “Next”, “Next”,

“Next”, “Install” ... (dann: deaktiviere “run” und “open help"”
Auswahl) "Finish”
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Ubungen HTML-Kit Erste Seite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Plug-ins

Zusatzlich noch die wichtigsten HTML-Kit Plug-ins:
© includeHTML

o “Next”, “Yes", “Next"”, wahle “Full installation”, “Next”, “Next”,
“Next”, “Install” ... (dann: deaktiviere “run” und “open help"”
Auswahl) "Finish”

@ w3c offline Referenzen

o “Next”, “Yes”, “Next”, “Install” ... “Finish”
o HTML-Kit starten, und unter [Edit > Preferences >

Help:“Help Options”] die Option “Use only local keyword help
files” aktivieren!)

e Mit F1 wird in der Editor-Ansicht dann die kontext-sensitive
Referenz aufgerufen.
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Ubungen ite Vorschau Inhalte Shortcuts Plug-ins

HTML-Kit — Plug-ins

Zusatzlich noch die wichtigsten HTML-Kit Plug-ins:
© includeHTML

o “Next”, “Yes", “Next"”, wahle “Full installation”, “Next”, “Next”,
“Next”, “Install” ... (dann: deaktiviere “run” und “open help"”
Auswahl) "Finish”

@ w3c offline Referenzen
o “Next", “Yes", “Next”, “Install” ... “Finish”
o HTML-Kit starten, und unter [Edit > Preferences >

Help:“Help Options”] die Option “Use only local keyword help
files” aktivieren!)

e Mit F1 wird in der Editor-Ansicht dann die kontext-sensitive
Referenz aufgerufen.

Beachte: Die obigen Plug-ins sind mit die einzigen, die einen eigenen Installer
mitbringen. Normalerweise laufen Plug-in Installationen aus dem gestartetem

HTML-Kit heraus — iiber: [Tools > Install > “Install Plugin..."].
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Résumé Zusammenfassung Noch Fragen?

Zusammenfassung

Im diesem ersten Teil des Seminars haben wir kennengelernt:
@ Doctype und Grundgeriist
@ Text und Uberschriften
© Bilder
@ CSS - Erste Einfiihrung
© Links and Anchors
@ HTML-Kit — Installation und erste Schritte
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Résumé Zusammenfassung Noch Fragen?

Noch Fragen?

e Folien erstellt mit IATEX (MiKTeX), TeXnicCenter Editor und
den latex-beamer Klassen.

@ Folien erhaltlich unter www.chr15tOph.de/webPublishing/
_pdf/fitAtWebdesign.pdf

@ (D) Christoph Peter Neumann — Quellcode der Folien auf
Anfrage: c.p.neumann@web.de
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http://www.miktex.org/
http://sourceforge.net/projects/texniccenter/
http://latex-beamer.sourceforge.net
http://www.chr15t0ph.de/webPublishing/_pdf/fitAtWebdesign.pdf
http://www.chr15t0ph.de/webPublishing/_pdf/fitAtWebdesign.pdf
mailto:c.p.neumann@web.de
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Agenda
Agenda

@ Grundelemente — 2. Teil
@ Wiederholung des ersten Teils
@ Listen
e Ubung
@ Tabellen
o Ubung

© Strukturierung durch “DIVisions”
e DIV
o CSS fiir Fortgeschrittene
e Ubung

@ Redundanzen Vermeiden
@ Editor Side Includes
@ includeHTML
e Ubung
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Agenda — Referenz

@ Grundelemente - 2. Teil
Wiederholung des ersten Teils
Listen

Ubung

Tabellen

Ubung
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Wiederholung des ersten Teils

Im ersten Teil des Seminars haben wir kennengelernt:
@ Doctype und Grundgeriist
@ Text und Uberschriften
© Bilder
@ CSS - erste Einfiihrung
© Links and Anchors
© HTML-Kit — Installation und erste Schritte
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Wiederholung des ersten Teils

Im ersten Teil des Seminars haben wir kennengelernt:
@ Doctype und Grundgeriist
@ Text und Uberschriften
© Bilder
@ CSS - erste Einfiihrung
© Links and Anchors
© HTML-Kit — Installation und erste Schritte

Als nachstes kommen Listen und Tabellen.

Dann DIVs und mehr CSS zur Strukturierung der Seite, z.B. fiir
Navigationsleisten.

Ausserdem Tools (— includeHTML) zur zentralen Speicherung von
redundanten Inhalten, wie Header, Footer und NavBar.
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Listen

In jeder Textverarbeitung gibt es zwei Sorten von Listen:
e Aufzihlungsliste — <ul>-Tag (engl. “unordered list")
e Nummerierte Liste — <ol>-Tag (engl. “ordered list”)
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Listen

In jeder Textverarbeitung gibt es zwei Sorten von Listen:
e Aufzihlungsliste — <ul>-Tag (engl. “unordered list")
e Nummerierte Liste — <ol>-Tag (engl. “ordered list”)

Die einzelnen Listeneintrdge sind innerhalb der ul/ol-Tags durch
das <li>-Tag ausgezeichnet.
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Listen

In jeder Textverarbeitung gibt es zwei Sorten von Listen:
e Aufzihlungsliste — <ul>-Tag (engl. “unordered list")
e Nummerierte Liste — <ol>-Tag (engl. “ordered list”)

Die einzelnen Listeneintrdge sind innerhalb der ul/ol-Tags durch
das <li>-Tag ausgezeichnet.

Jenachdem in welcher Listenumgebung die Eintrége stehen,
bekommen sie entweder einen fiihrenden “Bémmel” (ul), oder eine
inkrementell aufsteigende Nummer (ol).
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Bsp. “Unordered List”

<ul>
<li>Hund</ li>
<li>Katze</li>
</ul>

Anzeige dhnlich wie hier durch IATEX simuliert:

@ Hund

o Katze
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Bsp. “Ordered List”

<ol>
<li>Hund</ li>
<li>Katze</li>
</ol>

Anzeige dhnlich wie hier durch IATEX simuliert:

@ Hund
Q@ Katze
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Verschachtelte Listen

Unter verschachtelten Listen verstehen wir einfach Listen
unterschiedlicher Ebene, die sich meist durch ihre Einriickung
unterscheiden.

Hier wieder eine IATEX-"Simulation” als Beispiel:

Q@ Hund
@ Jagt Katzen
o ..

Q Katze
o ..

Mix ist erlaubt

Wie aus Textverarbeitungen bekannt, lassen sich UL und OL Listen
beliebig mischen!
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Verschachtelte Listen in HTML

<ol>
<li>Hund
<ol>
<li>Jagt Katzen</li>
<li>...</li>
</ol>
</ li>
<li>Katze
<ol><li>...</li></ol>
</li>
</ol>
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Verschachtelte Listen in HTML

<ol>
<li>Hund
<ol>
<li>Jagt Katzen</li>
<li>...</li>
</ol>
</ li>
<li>Katze
<ol><li>...</li></ol>
</ li>
</ol>

Attention Please!

Man beachte, dass das LI-Tags die “eingeschachtelten” Listen
vollstandig umschlieBen! Direkt unterhalb eines OL/UL-Tags
diirfen ausschlieBlich LI-Tags stehen!
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Ubung WYSIWYG — Nvu

@ Spass machen tut die Eingabe von Listen nur mit
WYSIWYG-Programmen wie Nvu. Dort hat man die iibliche
Eingabeunterstiizung — es lassen sich geschachtelte Listen
verschiedener Tiefe iiber Tab (und Shift-Tab) sehr leicht
eingeben.
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Ubung WYSIWYG — Nvu

@ Spass machen tut die Eingabe von Listen nur mit
WYSIWYG-Programmen wie Nvu. Dort hat man die iibliche
Eingabeunterstiizung — es lassen sich geschachtelte Listen
verschiedener Tiefe iiber Tab (und Shift-Tab) sehr leicht
eingeben.

@ Installation: “Next”, wahle “I accept the agreement”, “Next”,
“Next”, “Next”, “Next” und “Install” ... “Finish”
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Ubung WYSIWYG — Nvu

@ Spass machen tut die Eingabe von Listen nur mit
WYSIWYG-Programmen wie Nvu. Dort hat man die iibliche
Eingabeunterstiizung — es lassen sich geschachtelte Listen
verschiedener Tiefe iiber Tab (und Shift-Tab) sehr leicht
eingeben.

@ Installation: “Next”, wahle “I accept the agreement”, “Next”,

“Next”, “Next”, “Next” und “Install” ... “Finish”

@ Erster Start: “Close” (Tip of the Day). Dann: “Edit” >
“Preferences...” && “General” >> "When Saving or Publishing

Pages™ “retain original source formatting”
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Ubung WYSIWYG — Nvu

@ Spass machen tut die Eingabe von Listen nur mit
WYSIWYG-Programmen wie Nvu. Dort hat man die iibliche
Eingabeunterstiizung — es lassen sich geschachtelte Listen
verschiedener Tiefe iiber Tab (und Shift-Tab) sehr leicht
eingeben.

@ Installation: “Next”, wahle “I accept the agreement”, “Next”,

“Next”, “Next”, “Next” und “Install” ... “Finish”

@ Erster Start: “Close” (Tip of the Day). Dann: “Edit” >
“Preferences...” && “General” >> "When Saving or Publishing

Pages™ “retain original source formatting”

@ Nvu erleichtert auch die Eingabe von normalen Paragraphen
und Uberschriften!
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Ubung WYSIWYG — Nvu —

Christoph Peter Neumann HTML und CSS Kurs



Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Ubung WYSIWYG — Nvu —

@ Besonders bei chaotisch wiederholtem Einfiigen und Loschen
von Zeilenwechseln und Paragraphen kénnen sich bei Nvu im
HTML-Quelltext tiberfliissige Tag-Fragmente anhiufen.

@ = Losung:
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Ubung WYSIWYG — Nvu —

@ Besonders bei chaotisch wiederholtem Einfiigen und Loschen
von Zeilenwechseln und Paragraphen kénnen sich bei Nvu im
HTML-Quelltext tiberfliissige Tag-Fragmente anhiufen.

@ Ausserdem wird in der Regel wahrend der Eingabe von
verschachtelten Listen, gegen die “ausschlieBlich LI-Tags
unterhalb von UL/OL"™Regel verstoBen!

@ = Losung:
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Ubung WYSIWYG — Nvu —

@ Besonders bei chaotisch wiederholtem Einfiigen und Loschen
von Zeilenwechseln und Paragraphen kénnen sich bei Nvu im
HTML-Quelltext tiberfliissige Tag-Fragmente anhiufen.

@ Ausserdem wird in der Regel wahrend der Eingabe von
verschachtelten Listen, gegen die “ausschlieBlich LI-Tags
unterhalb von UL/OL"™Regel verstoBen!

@ = Losung:

@ Dinge durch “Riickgdngig” (StrG-Z) riickgéngig machen, und
nicht durch Léschen+Neuschreiben.

@ Mindestens vor dem Speichern:
“Tools” > “Markup cleaner” > "Clean up" aufrufen!!

Christoph Peter Neumann HTML und CSS Kurs



Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Ubung CSS — TopStyle

@ Die Eingabe von CSS kann von einem Programm wie TopStyle
durch Auto-Completion ungemein vereinfacht werden
(StrG-Space, wie in Programmierumgebungen iiblich).
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Ubung CSS — TopStyle

@ Die Eingabe von CSS kann von einem Programm wie TopStyle
durch Auto-Completion ungemein vereinfacht werden
(StrG-Space, wie in Programmierumgebungen iiblich).

@ Installation: “Next”, “Yes", “Next”, “Next” ... “Finish”
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Ubung CSS — TopStyle

@ Die Eingabe von CSS kann von einem Programm wie TopStyle
durch Auto-Completion ungemein vereinfacht werden
(StrG-Space, wie in Programmierumgebungen iiblich).

@ Installation: “Next”, “Yes”, “Next”, “Next" ... “Finish”
e Erster Start: "OK". Dann: wahle im “Style Inspector™ “CSS
Level 2"
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Ubung CSS - Beispiele

list —style —type: square;

ul ul, ol wul{
list —style —type: disc;

ol {

list —style —type: upper—roman;
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Tabellen

<table>
<tr>
<td>Personal information</td>
</tr>
<tr>
<td>Name</td>
<td>Christoph Peter Neumann</td>
</tr>
</table>

© Das Basis Tag nennt sich <table>
@ Es werden zuerst die Reihen (engl. “table row”, tr) angegeben.

© Spalten werden nicht angegeben. Stattdessen werden pro
Reihe mehrere Datenfelder (“table data”, td) angegeben, die
implizit zu einer gewissen Spaltenanzahl fiihren.
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Tabellen(2)

<table border="0" cellspacing="0" cellpadding="0"
summary="European Curriculum Vitae">

<tr>
<td class="heading3">Personal information</td>
</tr>
<tr>
<td class="leftHalf">
<ul><li>Name</ li></ul>
</td>
<td>Christoph Peter Neumann</td>
</tr>
</table>

@ Eine “blinde Tabelle” (ohne Gitternetzlinien)
@ Auch Listen, oder Bilder et al., sind als Inhalt erlaubt.
© Zwei Datenfelder sind auf CSS-Formatierung vorbereitet!
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Ubung

@ Nvu bietet einen sehr gelungenen Mechanismus um Tabellen
graphisch anzulegen und zu erweitern:
“Table” > “Insert” > “Table...”
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Grundelemente Wiederholung Listen Ubung Tabellen Ubung

Ubung

@ Nvu bietet einen sehr gelungenen Mechanismus um Tabellen
graphisch anzulegen und zu erweitern:
“Table” > “Insert” > “Table...”

@ Aber auch fiir HTML-Kit gibt es ein
sehr gutes Plug-In, das die Erstellung
von Tabellen sehr erleichtert:
hkTableStarter.

Nach der Installation
(“Tools” > “Install” > “Install Tl
Plugin..."), findet man es unter ww —
“Actions” > “Tables” >

“hkTableStarter".

Christoph Peter Neumann HTML und CSS Kurs


http://www.chami.com/html-kit/plugins/info/hktablestarter/

DIVs DIV CSS fiir Fortgeschrittene Ubung

Agenda — Refer

© Strukturierung durch “DIVisions”
e DIV
o CSS fiir Fortgeschrittene
e Ubung
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DIV CSS fiir Fortgeschrittene Ubung

Das DIV Tag

Das <div>-Tag erlaubt rechteckige Bereiche zu definieren. Diese
dienen dazu spezielle Inhalte zu kapseln:

<body>
<div id="header">
</div>

<div id="navbarContainerHack">
<div id="navbarContainer”>
</div>

</div>

<div id="content">
</div>

<div id="footer ">
</div>
</body>
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DIV CSS fiir Fortgeschrittene Ubung

Fiir DIVs gibt es praktisch immer durch CSS eine Definition, die
GroBe, Position und Ausrichtungsverhalten der DIVs bestimmen.

Bsp.:
#header{
background—color: transparent;
margin: 0;
padding: 10px Opx;
width: 100%;
height: 50px;
position: absolute;
}
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Offline Information

Eine genaue Diskussion der CSS-Definitionen fiir die DIVs findet
ausserhalb der Folien, auf Basis der Bsp.-Seiten statt!
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DIVs DIV CSS fiir Fortgeschrittene Ubung

CSS fiir Fortgeschrittene

Durch CSS kann man fiir verschiedene Ausgabemedien die
Anzeigeeigenschaften einstellen.

Die w3c hat verschiedene Medientypen definiert. Das wichtigste
(und mit das einzige, dass im Moment schon von Browsern
zusatzlich verstanden wird) ist der Typ “print”. Es bestimmt die
Druckansicht, wenn man die HTML-Seite aus dem Browser heraus

druckt.
@media print {
body {
color: Black;
background—color: White;
padding: Oem Oem Oem Oem;
}

Christoph Peter Neumann HTML und CSS Kurs
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CSS fiir Fortgeschrittene(2)

Man kann auch die Ausgabe/Ausdruck von Elementen, wie z.B.
Hilfs-DIVs (Header, Footer, NavBar), durch eine “display: none;”
Anweisung komplett unterdriicken.

@media print {

body {
color: Black;
background—color: White;
padding: Oem Oem Oem Oem;

}
hl,h2,h3,h4,h5,h6 { color: Black; }
a:link { color: Black; }

#header{ display: none; }
.navbar { display: none; }
#content{ padding: 0 0 0 0; }
#footer { display: none; }

}
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Vorschlag

Eine Moglichkeit ware an dieser Stelle die beispielhaften
CSS-Definitionen zu libernehmen — und sie zu variieren.
Oder: eigene Ideen? Fragen stellen!
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Redundanzen Editor Side Includes includeHTML Ubung

Agenda — Referenz

@ Redundanzen Vermeiden
o Editor Side Includes
@ includeHTML
o Ubung
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Redundanzen Editor Side Includes includeHTML Ubung

Editor Side Includes

Editor Side Includes bedeutet, dass HTML-Schnipsel in einer
zentralen Datei (XML !) verwaltet werden, und in den
XHTML-Dateien iiber Kommentar-Referenzierungen eingebunden

werden.
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Redundanzen Editor Side Includes includeHTML Ubung

Editor Side Includes

Editor Side Includes bedeutet, dass HTML-Schnipsel in einer
zentralen Datei (XML !) verwaltet werden, und in den
XHTML-Dateien iiber Kommentar-Referenzierungen eingebunden
werden.

Die genaue Syntax und Verwendung von Editor Side Includes sind
nicht standardisiert, sondern abhangig vom Editor!
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Redundanzen Editor Side Includes includeHTML Ubung

Editor Side Includes

Editor Side Includes bedeutet, dass HTML-Schnipsel in einer
zentralen Datei (XML !) verwaltet werden, und in den
XHTML-Dateien iiber Kommentar-Referenzierungen eingebunden
werden.

Die genaue Syntax und Verwendung von Editor Side Includes sind
nicht standardisiert, sondern abhangig vom Editor!

Ein Plug-In fir HTML-Kit, das Editor Side Includes erméglicht, ist
includeHTML — p.t.o.
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Redundanzen Editor Side Includes includeHTML Ubung

includeHTML

Bei includeHTML muss ein XML-Dokument angelegt werden:

<?xml version="1.0"7>
<snippetcollection>

<snippet key="header">
<! [CDATA[
<div id="header”>
<a id="headerAnchor"></a>
<hl id="siteName”">Christoph Neumann</hl>
</div>
11>
</snippet>

</snippetcollection>

Ein solches Snippet kann dann durch eine Kommentar-Referenz in
einer XHTML-Datei verwendet werden — p.t.o.
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Redundanzen Editor Side Includes includeHTML Ubung

includeHTML(2)

An der passenden Stelle im XHTML-Dokument wird folgender
Kommentar geschrieben:

<body>

<l——ih:includeHTML
file="_include /includeHTML .xml"

key="header"—>
<!—/ih:includeHTML—>
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Redundanzen Editor Side Includes includeHTML Ubung

includeHTML(3)

Wird jetzt includeHTML als Tool auf diese Datei angewendet,
dann wird der Kommentar wie folgt ersetzt:

<body>

<l——ih:includeHTML
file="_include /includeHTML .xml"
key="header"—>
<div id="header”>
<a id="headerAnchor"></a>
<hl id="siteName”">Christoph Neumann</h1>
</div>
<l—/ih:includeHTML—>
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Redundanzen Editor Side Includes includeHTML Ubung

Alternative Moglichkeiten

© Server Side Includes (SSI)

o Ahnlicher Mechanismus wie Editor Side Includes
e Standardisiert!
o Ersetzung durch den WebServer (bei Anfrage der HTML-Seite)

@ Dynamic Content Creation
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Redundanzen Editor Side Includes includeHTML Ubung

Alternative Moglichkeiten

@ Server Side Includes (SSI)
o Ahnlicher Mechanismus wie Editor Side Includes
e Standardisiert!
o Ersetzung durch den WebServer (bei Anfrage der HTML-Seite)
@ Dynamic Content Creation
Aus Datenbanken erzeugte Inhalte
Zum Beispiel: WebShops
(Dies ist die anspruchvollste Art HTML zu erzeugen ...)
(Auch Content Management Systeme (CMS) wie das
Open-Source Projekt Mambo basieren hierauf.)
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Redundanzen Editor Side Includes includeHTML Ubung

@ Download: includeHTML
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Redundanzen Editor Side Includes includeHTML Ubung

@ Download: includeHTML

@ Installation: “Next”, “Yes”, “Next”, wahle “Full installation”,
“Next”, “Next”, “Next”, “Install” ... (dann: deaktiviere “run" und
“open help” Auswahl) “Finish”
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Editor Side Includes includeHTML Ubung

Redundanzen

@ Download: includeHTML

@ Installation: “Next”, “Yes”, “Next”, wahle “Full installation”,
“Next”, “Next”, “Next”, “Install” ... (dann: deaktiviere “run" und

“open help” Auswahl) “Finish”

Plug-in versus Stand-alone

V.a. die Funktion “rekursiv alle html-Dateien einer ganzen
Verzeichnisstruktur abzuarbeiten”, ist aus HTML-Kit nicht
verfligbar, sondern nur iiber die eigenstiandige
includeHTML-Programmoberflache!

Christoph Peter Neumann HTML und CSS Kurs


http://www.rosenlundnielsen.dk/software/product_includehtml.php

Résumé Zusammenfassung Noch Fragen?

Zusammenfassung

Im diesem zweiten Teil des Seminars haben wir kennengelernt:
Q Listen
@ Tabellen
O DIVs
@ CSS fiir Fortgeschrittene
@ Editor Side Includes (includeHTML)
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Résumé Zusammenfassung Noch Fragen?

Noch Fragen?

@ Folien erstellt mit IATEX (MiKTeX), TeXnicCenter Editor und
den latex-beamer Klassen.

@ Folien erhiltlich unter www.chr15tOph.de/webPublishing/
_pdf/fitAtWebdesign.pdf

© (O Christoph Peter Neumann — Quellcode der Folien auf
Anfrage: c.p.neumann@web.de
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